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摘要
由此處開始寫中文摘要（請注意行首要縮排）。Start writing the Chinese abstract from this point, and please ensure proper indentation at the beginning of each line.
(範例Example)瑞士洛桑管理學院(IMD)發布2011年世界競爭力排名，在全球受評比的國家或地區中，我國排名第6，較去年進步2名，為近10多年來最佳成績。新聞局轉述IMD的意見，認為全球經濟衰退使中大型經濟體競爭力受衝擊，但台灣於其中表現出韌性。
新聞局長楊永明上午赴立法院接受媒體訪問時主動提及，這對我國是很大激勵，指出我國在兩岸關係改善、對外政策以及國內政策的穩定是進步的主要因素，至於ECFA 早收清單的上路助益，楊永明認為，ECFA可能是影響因素，但是早收清單上路是在去年，和IMD評估有時間差，可能不是重要因素。瑞士洛桑管理學院(IMD)發布2011年世界競爭力排名，在全球受評比的國家或地區中，我國排名第6，較去年進步2名，為近10多年來最佳成績。新聞局轉述IMD的意見，認為全球經濟衰退使中大型經濟體競爭力受衝擊，但台灣於其中表現出韌性。

關鍵字：與前段空一行，最多五個，新細明體，12點字，用逗號，分隔。
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[Start typing here.]  I would like to especially thank my mother and father, without whose guidance and support I would not be here. [Don’t forget to delete this paragraph.]
Acknowledgements must be written in complete sentences and in the third person.  i.e. not “Thanks, Mom and Dad!” but “I would like to especially thank my mother and father, without whose guidance and support I would not be here.”

The Acknowledgements page should be 1.5 line spaced and is the first page to bear a printed page number and be listed in the Table of Contents.
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[bookmark: _Toc357435723]INTRODUCTION
This is the first chapter of your manuscript. Often it is titled, 'INTRODUCTION'. You may use any title that suits your purpose. Heading 1 should all be capitalized.
[bookmark: _Toc98324476][bookmark: _Toc357435724]How to Use This Template [This is a First-Level Subheading]
This template file has been set up to meet the formatting requirements for theses and dissertations for the Department of Industrial Design at National Cheng Kung University. We basically follow the APA style but with minor adjustments. It's not magic, but it does get some of the confusing stuff taken care of: the margins are correct; the table of contents is formatted correctly; the necessary parts are in the right order; the page numbers will appear in the right place and in the right form; it has an acceptable font face and size. 
According to NCKU Library's requirements, your thesis should be printed on white A4 80gsm paper. The margins for the cover is 2.3 cm from the top side, 3 cm from the bottom side, and 2 cm from both right and left side of the page. In addition, the margins for the content should be 2.3 cm from the top side, 3.5 from the bottom side, 3 cm on the left side, and 2.5 cm from the right side. 
The Chinese title should be in 標楷體 16-point bold, center text. The English title should be in Times New Roman 14-point bold, center text. Author and Adviser’s names should be written in both Chinese and English. The Chinese name should be in標楷體 14-point bold, while the English name should be in Times Roman 14-point bold. All the text on cover should center align.
For body text, please use a 12-point Times New Roman font or, if this is unavailable, another proportional font with serifs, as close as possible in appearance to Times New Roman 12-point. If you need to use Chinese for citation, please use a 新細明體 12-point. The line spacing should be 1.5 and the alignment should be Justify Text that the text is aligned with both the left and right margins.
[bookmark: _Toc357435725]Replace Our Text with Yours [This is a Second-Level Subheading]
It will be pretty obvious when you need to get rid of some text in this template. For example, this part of the introduction needs to go before you start typing. Easiest way to delete it is to click your cursor in front of the first paragraph, scroll down to the last line in the chapter, hold the SHIFT key down, and click after the last letter. 'SHIFT-clicking' like this selects everything between the two clicks. 
Once you've selected the old text, press DELETE to get rid of it. Then, begin typing your text at the cursor.
[bookmark: _Toc357435726]Things to be Careful of
You can goof up the template. For example, when you delete the text on a page, be careful not to accidentally delete the marker, called a 'section break.' If you delete a section break, related to a page break, you may lose any  formatting that was particular to that page.
1.1.1.1   Using Tabs Correctly [This is a Third-Level Subheading]
If you want to type the Table of Contents manually, when you put your headings into the Table of Contents, List of Tables, etc. things should line up pretty well if you use tabs to skip to the next column. If you use spaces to indent or move to the next column, you will have a mess. As spaces in most font families are not fixed in size, things won’t necessarily line up perfectly and you may be required to fix it.  Moreover, when you use spaces rather than tab settings to determine placement of text, any change in words,  fonts, or margins requires a great deal of work to reformat.  If you use tab settings to control placement, making such changes becomes trivial. 
Because of the way tabs are set, if a chapter title or section name in the Table of Contents is very short, you may have to put an extra tab character to get the cursor to jump correctly. 
1.1.1.2   Using the Styles
The page and section heading styles have been set up as named styles in MSWORD. The page headings for each chapter heading (e.g. “CHAPTER 1  INTRODUCTION”) all use a style called “Headings 1 (標號1)” which all the words should be capitalized..  The first-level subheadings (example above) use a style called “Headings 2 (標號2)”.  The second-level subheadings use a style called “Headings 3 (標號3)”. The third-level subheadings use a style called “Headings 4 (標號4)”. If you accidentally delete any of those headings, go to the Format/Style menu, select the appropriate style and “Apply”.  If you cannot find the style under the list of styles, change the pull-down below it called “List” to “All styles”. In addition, the body text please use a style called “Body Text (本文)” instead of “Normal (內文)”.
[bookmark: _Toc357435727]SETTING UP A NEW CHAPTER
How do you begin a new chapter using this template? What must you do to get the page numbers to act correctly? Below are the steps for making a new chapter. 
[bookmark: _Toc98324477][bookmark: _Toc357435728]Moving to a New Chapter
To move to a new chapter, you must tell MS Word that you are moving on to a new page. You do this by applying a style called “Headings 1 (標題1).” A page break is automatically inserted before the heading which forces it to appear at the top of a fresh page.
[bookmark: _Toc357435729]CITATION AND REFERENCE
Again, this template basically follow the APA style but with minor adjustments. Thus, your citations and references should be formatted in APA style. To do so, I strongly recommend you use Endnote, a commercial reference management software package, used to manage bibliographies and references when writing essays and articles. Endnote can be downloaded from NCKU library website for free. Thesis writing will be much easier if you managing bibliographies, citations and references with Endnote. 
[bookmark: _Toc357435730]Citation Style in APA format
This paragraph illustrates two common ways of citing references within the text using APA style. According to Smith (2001), two of the most important issues in education today are curriculum and instruction. In fact, both curriculum and instruction are foundational to the educational enterprise (Jones, 2003). Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat.
In APA, when citing two authors outside parentheses use “and” but inside parentheses use “&”. For example, Smith and Jones (2004) have described various perspectives of curriculum and instruction. Another way to write it is that curriculum has been defined as “an integrated course of academic studies” (Jones & Smith, 2005, p. 14). Please notice here that when quoting in APA format, include the page number. An alternate way to cite a page number when quoting in APA format is show in the following sentence. Jones and Smith (2005) refer to instruction as “the activities of educating or instructing or teaching” (p. 15).
Other types of reference resources please check APA style's official website (http://www.apastyle.org) for more instructions.
[bookmark: _Toc357435731]References
The followings are some frequently used reference resources. However, this is not a complete list. If you have any question, please check with the APA style manual (Figure 2.1).
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[bookmark: _Ref231034247][bookmark: _Toc357437605]Figure 2.1  The Cover of Publication Manual of the American Psychological Association (6th edition)
[bookmark: _Toc357435732]Basic Form for Journal
Author, A. A., Author, B. B., & Author, C. C. (Year). Title of article. Title of Periodical, volume number(issue number), pages. doi:http://dx.doi.org/xx.xxx/yyyyy 
[bookmark: _Toc357435733]Basic Form for Books
Author, A. A. (Year of publication). Title of work: Capital letter also for subtitle. Location: Publisher.
[bookmark: _Toc357435734]Article or Chapter in an Edited Book
Author, A. A., & Author, B. B. (Year of publication). Title of chapter. In A.A. Editor & B.B. Editor (Eds.), Title of book (pages of chapter). Location: Publisher.
[bookmark: _Toc357435735]Article From an Online Periodical
Author, A. A., & Author, B. B. (Date of publication). Title of article. Title of Online Periodical, volume number(issue number if available). Retrieved from  http://www.someaddress.com/full/url/
[bookmark: _Toc357435736]Article From an Online Periodical with DOI Assigned
Author, A. A., & Author, B. B. (Date of publication). Title of article. Title of Journal, volume number, page range. doi:0000000/000000000000 or http://dx.doi.org/10.0000/0000
[bookmark: _Toc357435737]Article From a Database
Author, A. A., & Author, B. B. (Date of publication). Title of article. Title of Journal, volume number, page range. Retrieved from http://www.someaddress.com/full/url/
[bookmark: _Toc357435738]Newspaper Article
Author, A. A. (Year, Month Day). Title of article. Title of Newspaper. Retrieved from  http://www.someaddress.com/full/url/
[bookmark: _Toc357435739]Chapter/Section of a Web Document or Online Book Chapter
Author, A. A., & Author, B. B. (Date of publication). Title of article. In Title of book or larger document (chapter or section number). Retrieved from http://www.someaddress.com/full/url/
[bookmark: _Toc357435740]Nonperiodical Web Document, Web Page, or Report
Author, A. A., & Author, B. B. (Date of publication). Title of document. Retrieved from http://Web address
[bookmark: _Toc357435741]This is not a Complete List for References
Online Resources from the APA: http://www.apastyle.org; http://blog.apastyle.org/apastyle/
Citing Translated Sources in APA Style
[bookmark: _Toc357435742]Piaget, J. (1969). The psychology of the child (H. Weaver, Trans.). New York, NY: Basic Books.
Citing Chinese Sources in APA Style
中文文獻（需加註英譯）應置於英文文獻之前。中文文獻應依作者姓氏筆劃順序排列、英文文獻則依作者姓氏字母順序排列（若作者姓氏、字母相同時，則依序比較後列之字元）。於內文引用之寫法為「（作者中文姓名，西元出版年）」。此部分規定參考http://www.tana.org.tw/download/APA%20第6版範例下載.doc。
[bookmark: _Toc357435743]定期刊物
作者姓名（姓在先）（西元出版年）. 標題. 期刊名稱，卷（期），起訖頁數。
蔡淑鳳（2011）. 護理專業發展之機會與挑戰－臺灣護理精彩一百. 護理雜誌，58（3），5-11 。[Tsay, S. F. (2011). The opportunities and challenges of nursing professional development: Celebrating 100 years of nursing in Taiwan. The Journal of Nursing, 58(3), 5-11.]
[bookmark: _Toc357435744]一本書、書的一章、翻譯書
作者姓名（西元出版年）. 書名. 出版地：出版商。
陳美燕, 黃世惠, 張淑紅, 簡欣怡, 阮玉梅, 張彩秀…萬國華等 （2011）. 公共衛生護理學 （再版）. 台北市：啟英文化。 [Chen, M. Y., Huang, S. H., Chang, S. H., Jian, X. Y., Ruan, Y. M., Chang, T. H., … Wan, G. H. (2011). Public health nursing (2nd ed.). Taipei City, Taiwan, ROC: Ching Culture.]
林元淑、黃靜微（2008）. 新生兒及其護理. 於陳月枝總校閱，實用兒科護理 （五版，38-112 頁）. 台北市：華杏。 [Lin, Y. S., & Huang, C. W. (2008). Nursing care of newborns. In Y. C. Chen (Ed.), Practical pediatric nursing (5th ed., pp. 38-112). Taipei City, Taiwan, ROC:  Farseeing.]
American Psychological Association. (2011) . 美國心理學會出版手冊：論文寫作格式六版（陳玉玲、王明傑譯）. 台北市：雙葉書廊。（原著出版於2010）[American Psychological  Association. (2011). Publishing manual of the American Psychological Association, 6th ed. ( Y. L. Chen & M. C. Wang, Trans.). Taipei City, Taiwan, ROC: Yeh Yeh Book Gallery.   (Original work published 2010)]
[bookmark: _Toc357435745]政府部門、機構、其他組織的網路資料
作者姓名（西元年，月日）. 題目名稱. 取得網址。
疾病管制局（2011）. 98 傳染病統計暨監視年報. 取自http://www.cdc.gov.tw/public/Data/ 111911421871.pdf [Centers for Disease Control, Taiwan, ROC. (2011). 2009 annual statistical report: Infectious diseases and surveillance. Retrieved from http://www.cdc.gov.tw/public/ Data/111911421871.pdf]
[bookmark: _Toc357435746]碩、博士論文
作者姓名（西元年）. 論文名稱（未發表的博/碩士論文）. 城市：學校系所。
林麗梅（2010）．加護病房胃酸抑制藥物使用與發生院內感染型肺炎危險之相關性探討（未發表的碩士論文）．臺北醫學大學藥學研究所。[Lin, L. M. (2010). The use of acid-suppressive medications and the risk for hospital-acquired pneumonia in intensive care units (Unpublished master’s thesis). Taipei Medical University, Taiwan, ROC.]
[bookmark: _Toc357435747]未出版的論文發表、海報發表及研習會之文章
作者（西元年，月）. 題目. 論文/海報發表於主辦單位名稱之研習會名稱. 城市、國家：主辦地點。
張聿仁, 江琳盈 & 白玉珠（2011，9 月）. 耳穴按壓改善護理人員睡眠品質之效益分析. 海報發表於台灣護理學會主辦之第二十七次護理研究論文發表會暨兩岸護理學術交流. 台北市：國立臺北護理健康大學。[Chang, Y. J., Chiang, L. Y., & Pan, Y. C. (2011, September). Effectiveness of auricular acupressure on insomnia in nurses. Poster session presented at the 27th Annual Nursing Research Conference of the Taiwan Nurses Association, Taipei City, Taiwan, ROC.]
[bookmark: _Toc357435748]研究計畫
作者姓名（含計劃主持人及研究人員）（西元年）. 計畫題目名稱（計畫所屬單位及編號）. 城市：出版或製作此報告的單位。
黃璉華（2010）．護理正向執業環境的探討與改善效果（研究計劃編號TWNA-0991002）．台北市：台灣護理學會。[Huang, L. H. (2010). The effects of improving positive practice environments on nurses in a medical center (Research Grant TWNA-0991002). Taipei City, Taiwan, ROC: Taiwan Nursing Association.]
[bookmark: _Toc357435749]Citing Translated Sources in APA Style
If you are citing a source, such as interview or text, in another language, and you paraphrase into English, or translate a quotation into English and include it as part of your paper, it's not necessary to note that you did the translation at every cite since everything not attributed to another is assumed to be the work of the author. However, many authors state this in a footnote or parenthetical comment at the first translation (e.g., "all translations from Chinese are my own").
[bookmark: _Toc357435750]Tables and Figures
Tables and figures should appear on the same or next page as the first reference to them in the text. Do not break them across pages unless necessary. In addition, use only horizontal lines to delimit tables. The numbering of tables and figures should restart every chapter, in which the numbering takes the form “chapternumber.tablenumber”, e.g. Table 3.1 shows a comparison of instruction with no instruction on students’ achievement, attitudes toward subject matter, and attitudes toward learning. Table in appendices will be numbered “appendixletter.tablenumber”, e.g. Table A.1, A.2, B1, C.1…C.16. 

[bookmark: _Ref357115261][bookmark: _Toc357437592]Table 3.1  Comparison of the Effects of Instruction on Students' Achievement and Attitudes
	Outcome Measures
	With Instruction
	Without Instruction

	Achievement
	75.23
	61.05

	Attitudes toward subject matter
	10.48
	8.83

	Attitudes toward learning
	9.14
	8.65



Figure 3.1 shows an illustration of the overlap between curriculum and instruction. The figure number and caption go at the bottom of the figure on one line (unless it is too long). Figure and the number are italicized, but the caption is not. Capitalize only the first word and proper names in the caption.

[image: ]
[bookmark: _Ref357115324][bookmark: _Toc357437606]Figure 3.1  Diagrammatic illustration of the overlap between curriculum and instruction.
[bookmark: _Toc357435751]Generate the LIST OF TABLES and FIGURES by WORD
Before you can automatically generate the LIST OF TABLES and FIGURES, you have to create captions so that WORD will know how many tables and figures you have. 中文請參考 Microsoft Word 的說明 (按F1)，搜尋［插入標號］及［交互參照］。
[bookmark: _Toc357435752]Use captions
You can add a caption to any picture, table, or equation in your document. You can also have Word automatically insert captions for some items. In addition, you can change the numbering format or change the label title.
Add a caption
Every caption is composed of a label and a number. You can add new labels and change the numbering format. Captions for each kind of object can be numbered sequentially. For example, you can have Figure 1, Table 1, Table 2, Table 3, Figure 2, Table 4, and so on. To do so, in your document, select the item that you want to add a caption to. On the Insert menu, click Caption. Select the options that you want such as Table or Figure.
[bookmark: _Toc357435753]Cross reference
A cross-reference refers to an item that appears in another location in a document. For example, you can mention "Figure 1" in your document and refer the reader to the figure's location elsewhere in the document. By default, Word inserts a cross-reference as a hyperlink that you can click to be taken directly to the cross-referenced item. You can create cross-references to items such as headings, footnotes, bookmarks, captions, and numbered paragraphs. If you add or remove content that causes the referenced item to move, you can update the cross-reference.
Create a cross-reference
You can insert cross references to any existing numbered items, headings, bookmarks, footnotes, endnotes, equations, figures, or tables in your document.
1. On the View menu, click Print Layout.
2. Position the cursor where you want the cross-reference to appear. For example, if you introduce your cross-reference with the words For more information, see, add a space after the word see, and then position the cursor after the space.
3. On the Insert menu, click Cross-reference.
4. On the Reference type pop-up menu, click the kind of item you want to refer to.
5. On the Insert reference to pop-up menu, click the description that you want to appear in the document. For example, if you create a cross-reference for a table, selecting Above/below inserts the word "above" if the table is located above the cross-reference.
6. In the For which caption box, click the specific item you want the cross-reference to refer to.
7. Click Insert.
Update a cross-reference from one page to another
Use this procedure if you move the item that you're cross-referencing from one page to another. For example, if you have a cross reference to a table and then move the table to another page, you must update the cross reference. On the View menu, click Print Layout, then do one of the following as listed in Table 3.2:

[bookmark: _Ref231352503][bookmark: _Toc357437593][bookmark: _Ref231352497]Table 3.2  How to update a cross-reference
	To
	Do this

	Update a specific cross-reference
	Point to the cross-reference, press CONTROL and click the cross-reference that you want to update, and then click Update Field.

	Update all cross-references in the document
	Select the whole document, press CONTROL and anywhere on the document, and then click Update Field.
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[bookmark: _Toc357435755]DESCRIPTION OF DEFAULT SUBHEADING SCHEME
The default format for chapter-level headings is bold, all upper case, and centered.  Otherwise the font is the same font family and the same size or no more than 2 font points larger (e.g. 14 points vs. 12).
Auto numbered list in Appendix will make styling menu too complicate to understand intuitively. Thus, I would suggest you to apply Headings 1 (標題1) to the first level subheadings here and then turn the numbering function off by clicking the “numbered list” icon in “Home” tab. 
[bookmark: _Toc98324478][bookmark: _Toc357435756]A.1  First-Level Subheading
The default format for first-level subheadings is centered, bold, and upper and lower case (UC/LC). Capitalize words as you usually would in a title. The wording and capitalization of all subheadings should exactly match the corresponding entry on the 'contents' page. A blank line above the subheading has already been built into this template so it is not necessary to leave another blank line before headings so long as you are using the proscribed heading and subheading styles.  Styles were discussed in Chapter 1 of this document.
[bookmark: _Toc357435757]A.1.1  Second-Level Subheadings
Second-level headings are justified left. The second-level subheading will also be UC/LC and bold.  That is the style built into this WORD document. The font size should be the same size as the text font. Since a blank line above each subheading was built into this template, it is not necessary to leave another blank line before headings so long as you are use the proscribed subheading style.
A.1.1.1 Third-Level Subheadings
Third-level subheadings are plain UC/LC text and underlined. Capitalize as with the other subheadings. 
[bookmark: _Toc357435758]VITA  [optional – Ph.D. only]
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6  Instru ction    J o n e s   a nd Smith (2005) refer to instruction as “the activities of  educating  or  instru cting  o r   teaching” (p. 15). Lorem ipsum dolor sit amet, consectetur  adipis icing  e lit,  s e d  d o  e i u s m o d tempor incididunt ut labore et dolore magna aliqua. Ut  e n i m  a d  m i n i m   v e n i a m ,  q u i s  n ostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo  c o n s e q u a t .  T a b le 1 shows a comparison of instruction with no instruction  on  students’  a c h i e v e m e n t ,  a ttitudes toward subject matter, and attitudes toward learning.    T a b l e  1   Comparison of the Effects of Instruction on Students’ Achievement and  A t t i t u d e s   O u t c o m e  M e a s ures  With Instruction  Wi t h o u t  I n s t r u c t i o n   A c h i e v e m e n t    75.23  61.05  Attitud e s  to ward subject matter  10.48  8.83  A t t i t u d e s  t o w a rd learning  9.14  8.65  This is an alternate way to cite a page  number when quoting in APA format.  Except for certain exceptions (e.g., p and r  values), report data to only 2 decimal places.  Tables  and  figur e s  should  appear on  the sa me or ne xt  page as the first  reference  to them in the te xt. Do not  break  them  acro ss  pages  unless  necessar y .  In APA, the  table number  goes on one  line. The  italic ized  title  appears on th e  next line.  Capitalize  each  maj o r  w o rd  i n   the  table  title.  Use onl y   horizontal  lines  to  delimit  tables.     Fi g u r e   1 shows an illustration of the overlap between curriculum  a n d  i n s t r u c t i o n .   Lorem   ipsum  dolor sit amet, consectetur adipisicing elit, sed do eiusmod  tem por  incididunt  ut  labore et dolore magna aliqua. Ut enim ad minim veniam ,  q u i s  n o s t r u d   exercitation  ullamco laboris nisi ut aliquip ex ea commodo consequat.   
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F i g u r e  1

. Diagrammatic illustration of the overlap between curriculum  and instru ction. 
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